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Zusammenfassung

Calligra Stage ist das Präsentationsprogramm der Calligra-Anwendungen.
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Kapitel 1

Einleitung

WICHTIG
Aktualisierte Versionen dieses Dokuments finden Sie unter http://docs.kde.org.

Calligra Stage ist das Präsentationsprogramm der Calligra-Anwendungen. Mit Hilfe von Calli-
gra Stage können Sie einen Satz Folien für eine Bildschirmpräsentation oder für den Ausdruck
zusammenstellen. Die Folien können Texte und Grafiken in unterschiedlichen Formaten und na-
türlich Komponenten aller anderen Calligra-Programme enthalten.

Calligra besteht aus einer Sammlung von Programmen, die aufeinander abgestimmt sind. Es gibt
eine Übersichtsdokumentation für Calligra und für jede Komponente von Calligra eine eigene
Dokumentation:

• Calligra Words - eine rahmenbasierte Textverarbeitung.

• Calligra Tables - eine Tabellenkalkulation.

Calligra ist ein freies (Open Source) Programm und wird unter den Lizenzbedingungen der GNU
General Public License veröffentlicht.
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Kapitel 2

Eine ausführliche Anleitung

Neil Lucock
Krishna Tateneni
Anne-Marie Mahfouf
Deutsche Übersetzung: Hans-Frieder Hirsch

In dieser Anleitung wird Calligra Stage vorgestellt. Es wird im Verlauf dieser Anleitung eine
einfache Präsentation mit einigen einfachen Zusatzeffekten erstellt.

2.1 Ein neues Dokument erstellen

Beim Start von Calligra Stage erscheint der Calligra- Startdialog.

Wählen Sie auf der linken Seite Folien und klicken Sie dann auf die Vorlage Leer (Im Bildschirm-
foto oben hervorgehoben). Soll diese Vorlage immer beim Programmstart verwendet werden,
aktivieren Sie die Einstellung Immer diese Vorlage verwenden.

Durch Klicken auf Diese Vorlage verwenden öffnen Sie den Folieneditor. Darin können Sie Foli-
en anzeigen und bearbeiten, einschließlich der darin enthaltenen Objekte.

Die Präsentation enthält zurzeit nur eine leere Folie, daher wählen Sie im andockbaren Dialog
Folienlayouts die obere linke Folie mit dem einzelnen Textfeld.
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Durch Doppelklicken in das Textfeld ändern Sie den Cursor in einen senkrechten Balken, der
Ihnen anzeigt, dass Sie Text eingeben können.

Tippen Sie etwas Text ein.

Um die Eingabe zu beenden, klicken Sie außerhalb des Textrahmens.
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2.2 Eine neue Seite hinzufügen

Fügen Sie nun eine neue Folie in Ihr Dokument ein. Dazu klicken Sie im Menü Folie auf Folie
einfügen ....

Nun können Sie nun eine Vorlage für die neue Folie auswählen. Wählen Sie nun das blau her-
vorgehobene Layout mit einer Spalte.

Das neue Folienlayout erscheint im Folieneditor. Um zwischen den zwei Folien zu wechseln,
wählen Sie die gewünschte Folie in der Folienliste auf der linken Seite (im Bildschirmfoto her-
vorgehoben).

Die neu eingefügte Seite enthält zwei Textfelder, das erste für den Titel und das zweite für eine
Liste von Einträgen.

8



Das Handbuch zu Calligra Stage

Doppelklicken Sie in das erste Textfeld und geben Sie einen Titel für die Seite ein. Doppelklicken
Sie dann in das zweite Textfeld mit dem Aufzählungszeichen. Geben Sie Ihren Text ein und be-
enden Sie den Absatz mit der Eingabetaste. Am Anfang des nächsten neuen Absatzes erscheint
automatisch wieder das Aufzählungszeichen.

Beenden Sie die Eingabe durch Klicken außerhalb des Textfeldes.
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2.3 Ein Bild einfügen

Gehen Sie zurück zur ersten Folie, indem Sie in der Folienliste links im Fenster darauf klicken.

Die Titelseite soll jetzt mit einem ansprechenden Logo etwas „aufgepeppt” werden. Dazu aktivie-
ren Sie den andockbaren Dialog Objekt hinzufügen mit Einstellungen → Andockbare Dialog
aus dem Menü.
Wählen sie jetzt das Bild aus dem andockbaren Dialog Objekt hinzufügen und klicken Sie mit
der linken Maustaste auf die Folie, um die Grafik mit der linken oberen Ecke dort in Originalgrö-
ße einzufügen, oder ziehen Sie mit der linken Maustaste ein Rechteck für die Position und Größe
der Grafik.
Ein Dateiauswahldialog erscheint. Dieser Dialog und andere KDE-Standarddialoge werden aus-
führlich in der KDE-Dokumentation erläutert. Sie können das Dateisystem durch Klicken auf
die Ordner-Symbole oder mit Hilfe der Browser-Knöpfe durchsuchen. Mit der Taste Pfeil auf
erreichen Sie die nächsthöhere Ordnerebene.
Wählen Sie eine Datei und drücken Sie den Knopf OK.

Nun wird die Grafik in die Folie eingefügt. An den Rändern der Grafik werden kleine Quadrate
als Ziehpunkte angezeigt.

Platzieren Sie den Mauszeiger auf die Grafik und ziehen Sie sie in die Mitte der Titelseite. Mit
Hilfe der Anfasser ziehen Sie die Grafik dann auf die gewünschte Größe.

Damit haben Sie das Bild auf der Titelseite eingefügt.

2.4 Ein Calligra-Objekt einfügen

Fügen Sie ein anderes Calligra-Objekt unter der Grafik ein, zum Beispiel ein Diagramm.

Jedes Calligra-Objekt kann in eine Calligra Stage-Folie eingefügt werden. Wählen Sie nun ein
Diagramm aus dem andockbaren Dialog Objekte hinzufügen.

Wählen Sie Diagramm und ziehen Sie mit dem Mauszeiger ein Rechteck auf der Calligra Stage-
Folie, in dem das Diagramm eingefügt werden soll.
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Lassen Sie die Maustaste los, dann wird eine Diagrammvorlage in die Folie eingefügt. Immer
wenn Sie das Diagramm bearbeiten, werden die Werkzeugoptionen für das Diagramm im an-
dockbaren Dialog angezeigt.

Um das eingebettete Diagramm zu verschieben, zu vergrößern oder zu verkleinern oder um es zu
löschen, wechseln Sie zum Werkzeug für Objekte und klicken dann irgendwo in das Diagramm.
Es wird jetzt mit einem grünen Rand und mit je einem kleinen gelben Quadrat an jeder Ecke und
in der Mitte jeder Seite angezeigt.

Wenn Sie den Mauszeiger über eins der Quadrate bewegen, wird als Pfeil mit zwei Spitzen ange-
zeigt. Sie können die Größe des Diagramms nun ändern, indem Sie eins dieser Quadrate mit der
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gedrückten linken Maustaste ziehen. Um das Diagramm zu löschen, klicken Sie mit der rechten
Maustaste auf eins der Quadrate und wählen Sie Löschen.

Um das Diagramm zu verschieben, bewegen Sie den Cursor hinein. Der Cursor wird zu einem
Kreuz, halten Sie jetzt die linke Maustaste gedrückt und Sie können das Diagramm dorthin be-
wegen, wo Sie es haben wollen.

Um das Aussehen des Diagramms wieder zu normalisieren, klicken Sie einfach irgendwo außer-
halb des Diagramms in die Tabelle.

Um das Format des Diagramms selbst zu ändern, doppelklicken Sie mit der linken Maustaste in-
nerhalb des Diagrammbereichs. Die Werkzeugoptionen für Diagramme werden dann angezeigt
und sie können dann damit die Eigenschaften des Diagramms wie den Typ, Beschriftungen, Ach-
sen und Daten ändern.
Klicken Sie mit der linke Maustaste außerhalb des Diagramms, um die Folie in Calligra Stage
weiter zu bearbeiten.
Klicken Sie einmal auf das Diagramm und Sie können es verschieben oder an den Kanten oder
Ecken ziehen, um es in der Größe zu verändern. Doppelklicken Sie auf das Diagramm, dann kön-
nen Sie das Diagramm in den Werkzeugoptionen bearbeiten und alle Eigenschaften verändern.

2.5 Die Textfarbe des Titels verändern

Der Titeltext der Titelseite soll zum Abschluß noch in blauer anstatt schwarzer Farbe dargestellt
werden. Dazu wählt Sie den Textrahmen durch doppelklicken und dann den Text im Rahmen.

Öffnen Sie die Farbauswahl, indem Sie auf das Symbol in den Werkzeugoptionen der
Textbearbeitung klicken, für dieses Symbol wird Textfarbe als Kurzinfo angezeigt.
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Wählen Sie hier eine blaue Farbe.
Damit ändert der ausgewählte Text seine Farbe. Die genaue Farbe des ausgewählten Textes hängt
von ihrem System und dem eingestellten Farbschema ab.

ANMERKUNG
Die Farbe für Texte können Sie auch auf der Karteikarte Dekorationen des Dialogs Schriftart aus-
wählen mit Schriftart aus dem Menü Format oder dem Kontextmenü einstellen.

Beenden Sie die Bearbeitung durch Klicken außerhalb des Textfeldes.

Starten Sie jetzt mit den beiden Folien eine Vorführung. Klicken Sie auf das Symbol Präsentation
starten in der Werkzeugleiste. Die erste Folie wird auf dem Bildschirm angezeigt.

Durch Klicken auf den Bildschirm oder mit der Taste Bild ab wechseln Sie zur zweiten Folie.
Um die Präsentation zu beenden, drücken Sie die Taste Esc.
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Kapitel 3

Ausführliche Anleitungen

Neil Lucock
Krishna Tateneni
Brad Hards
Danny Allen
Anne-Marie Mahfouf
Übersetzung: Burkhard Lück

Dieses Kapitel soll zeigen, wie die häufigsten Aufgaben in Calligra Stage durchgeführt werden.

3.1 Erstellung einer HTML-Präsentation

Erstellt HTML-Seiten mit zugehörigen Navigationselementen aus einer vorhandenen Präsentati-
on.
Zuerst erstellen Sie eine neue oder öffnen eine vorhandene Präsentation. Dann klicken Sie auf
Datei Als HTML exportieren ...

In einem Dialog geben Sie dann einige Einstellungen ein:
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Geben Sie einen Titel und den Autor ein. Wählen Sie dann die Folien, die exportiert werden
sollen. Möchten Sie Namen von Folien ändern, der auf der HTML-Seite angezeigt wird, dop-
pelklicken Sie auf den Namen und bearbeiten ihn.

In der Ausgabevorschau werden die Folien verkleinert angezeigt. Sie können hier die richtige
Reihenfolge der Folien überprüfen und mit den Knöpfen < and > durch die Präsentation blättern.

Wählen Sie dann eine Stilvorlage mit den Einstellungen für die HTML-Seiten aus.

Nun können Sie den Ihre HTML-Präsentation erstellen, drücken Sie dazu auf den Knopf Expor-
tieren und wählen einen Ordner zum speichern aus.

Damit werden am angegebenen Pfad neue html/ - und pics/ -Ordner angelegt:

Die neu erstellte Datei index.html dient als Einstiegspunkt zum Start der Präsentation.

Für einen Test öffnen Sie mit dem Dateiverwaltungsprogramm oder Browser die Datei index.
html. Klicken Sie auf den Start, so wird die erste Seite der Präsentation angezeigt. Der weitere
Ablauf entspricht einer Calligra Stage-Präsentation.

Mit den blauen Pfeilen können Sie in den Folien blättern, ein Klick auf das Foliensymbol bringt
Sie zum Inhaltsverzeichnis der Präsentation.

TIP
Um Ihre Präsentation zu veröffentlichen, laden Sie die neu erstellten Seiten ins Internet, ohne dabei
die Ordnerstruktur zu verändern.

3.2 Vorlagen für Calligra Stage erstellen

Die Calligra Stage-Bibliothek kann auf einfache Weise um eigene Vorlagen erweitert werden.

Wenn Sie eine von Ihnen erstellte Vorlage wiederverwenden wollen, können Sie sie als Vorlage
speichern.

Dieses Anleitung erläutert die Erstellung und Abspeicherung einer eigenen Vorlage.

Als erstes starten Sie Calligra Stage und erstellen ein neues Dokument.

Um die Folie ein bisschen ansprechender zu gestalten, ändern Sie den Folienhintergrund. Wählen
Sie Dokumenthintergrund im andockbaren Dialog Werkzeuge.

Der Hintergrund soll attraktiv aussehen, daher wählen Sie mit Bild festlegen eine Grafik als
Hintergrund auswählen. Probieren Sie einfach verschiedene Einstellungen aus, bis das Ergebnis
zufriedenstellend ist.
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Damit ist gewünschten Hintergrund für die Seite eingestellt. Erstellen Sie ein Textfeld und geben
Sie eine Überschrift für die Folie ein:

Wenn Sie mit Ihrer Vorlagen zufrieden sind, klicken Sie auf Datei →Speichern unter und wählen
den Dateityp ODP-Vorlage.
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Kapitel 4

Allgemeine Hinweise und Tipps für
großartige Präsentationen

Neil Lucock
Krishna Tateneni
Übersetzung: Burkhard Lück

Bevor man eine Präsentation mit Calligra Stage erstellen kann, gibt es eine Reihe von Vorberei-
tungen, die man am besten ohne Computer trifft. Man sollte sich ein Blatt Papier nehmen und
den Inhalt der Präsentation planen. Dabei ist es egal, ob man für eine Unterrichtsstunde irgend
welcher Art plant oder seinen Chef von seinen Plänen und Ideen überzeugen will. Man muss
entscheiden, was man eigentlich mit der Präsentation sagen will. Das beinhaltet die Themen, die
Struktur, die Überschriften. Den Inhalt muss man an dieser Stelle noch nicht festlegen.

Zu jeder Überschrift notiert man die Fakten, die genannt werden sollen. Man muss versuchen,
überzeugende Argumente zu finden. Die Fakten sollten in wichtige, weniger wichtige und zu-
sätzliche, die man bei zu viel Zeit einbringen möchte, eingeteilt werden.

Nachdem man damit fertig ist, ist als Nächstes die verfügbare Zeit zu beachten. Zehn Minu-
ten erscheinen zu Beginn unendlich lang zu sein, sind allerdings für eine informative Rede nur
eine sehr kurze Zeitspanne. Daher ist es nötig, die Präsentation oft unter Beachtung der zur Ver-
fügung stehenden Zeit zu üben. Das hat viele Vorteile: Erstens entwickelt man ein Gefühl für
die richtige Geschwindigkeit. Man sollte sich zur Regel machen, eine vorgegebene Zeit nicht zu
überschreiten. Zweitens hat man die Präsentation schon einige Male durchgeführt, wenn man sie
schließlich vor Publikum vorträgt. Drittens hat man sich die richtigen Worte bereits im Kopf zu-
rechtgelegt. Man gewinnt eine gewisse Freiheit, über die Inhalte der jeweiligen Folie zu sprechen,
ohne sie wortwörtlich vor zu lesen.
Mit Calligra Stage kann man momentan noch keine Notizen für den Sprecher erstellen, aber
normale Folien reichen aus. Man sollte einige Folie für sich selbst auf Papier ausdrucken und
einige für den Overheadprojektor. Die Textgröße sollte so gewählt sein, dass man den Text auch
aus größerer Entfernung lesen kann. Eine Größe von 14 bis 16 Punkt ist ein guter Richtwert. Ein
Skript ist nicht zu empfehlen.

Man sollte sich mit einem Overheadprojektor vor der Präsentation vertraut machen. Es ist sinn-
voll, die Lampe und Ersatzlampe auf einwandfreie Funktion zu überprüfen und eventuell die
Linsen und die Oberflächen zu reinigen. Üben Sie, wenn Sie selten mit Projektoren arbeiten.
Auch die Projektionsfläche muss sauber sein. Beim Üben sollte man etwa fünf Sekunden (zählen
Sie „Eintausendundeins, Eintausendundzwei ....”) Zeit zum Wechsel einer Folie einplanen. Man
kann entweder einen Laserpointer an der Projektionsfläche oder einen Bleistift o. Ä. auf dem
Overheadprojektor selbst verwenden, um auf etwas zu zeigen. Bleistifte neigen zum Wegrollen,
falls man gegen den Projektor stößt.
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Man muss die eigene Standposition einplanen. Vor der Projektionsfläche ist kein guter Platz, et-
was seitlich ist eine geeignete Position, damit das Publikum Sie sehen kann. Wenn man die Folie
auf eine weiße Tafel projiziert, kann man auf der Projektion zeichnen. Wenn Sie einen PC mit
einem digitalen Projektor arbeiten, können Sie auch auf den Folien mit dem Präsentationsstift
von Calligra Stage zeichnen. Freihändiges Zeichnen mit einer Maus erfordert allerdings einige
Übung. Bei einem Overheadprojektor kann man auch transparente Folien auf die Präsentations-
folie legen und einen Folienstift verwenden.

Man sollte wegen Blendeffekten unbedingt vermeiden, direkt in das Licht zu sehen. Falls man
den OHP einige Minuten nicht benötigt, sollte man ihn ausschalten. Man sollte sich auch mit dem
Präsentationsraum vertraut machen. Die Positionen von Steckdosen sollte man kennen und die
Bedienung von Lichtschaltern und Vorhängen sollte ausprobiert werden. Das vermeidet Fehler
und gibt Sicherheit. Man sollte sich auch ein paar Gedanken über Pannen machen und Alter-
nativen einplanen. Papierausdrucke der Folien, die im Notfall fotokopiert und an die Zuhörer
verteilt werden können, sind sehr sinnvoll.

Bisher wurde noch nichts über den Inhalt der Präsentation gesagt. Bisher hat man nur ein Blatt
Papier mit den Inhalten vor sich. Bei der Erstellung der Präsentation sollte man sich bei jeder
Folie fragen, ob das Verständnis durch die Folie verbessert wird. Man kann fürchterliche Präsen-
tationen durchführen, wenn man nur Folien gefüllt mit Texten produziert und diese dann den
Zuhörern vorliest (das ist unmöglich, da jeder Zuhörer still schneller liest als der Vortragende
laut).Man sollte zunächst nichts anderes als einen Titel und eine Nummer auf jede Folie schrei-
ben. Dann versucht man, eine Zeichnung des Inhalts anzufertigen. Diese Zeichnung kann man
den Zuhörern dann erklären. Auf diese Weise sind die Zuhörer nicht schneller und der Vortra-
gende macht einen kompetenten Eindruck. Die Zeichnungen dienen gewissermaßen als Stich-
wortgeber. Eine Folie sollte eine Ergänzung zum Vortrag sein und kein Duplikat des Vortrags.
Damit wird die Konzentration des Publikums gefesselt und nicht zerstreut.

Ein Beispiel zur Illustration: Eine Unterrichtsstunde für Bahnangestellte zum Verhalten bei Un-
fällen. Inhalt der Folie soll sein, wie man Gefahrgüter sicher von einem entgleisten Wagen auf
einen Lastwagen umlädt. Das Folienbild zeigt einen Tankwagen für Gase oder Flüssigkeiten.
Auf der Seite steht „Tödliche Chemiefabrik” geschrieben. Folgende wichtige Dinge sollen dazu
gesagt werden: Erstens, der Strom in benachbarten Oberleitungen muss abgeschaltet werden,
bevor man irgend etwas anderes unternimmt. Daher wird ein Pfeil zu einem Strommasten ge-
zeichnet und der erforderliche Sicherheitsabstand an diesen Pfeil geschrieben. Zweitens dürfen
die Wagoninhalte nicht bei Dunkelheit oder Gewitter umgeladen werden. Daher wird ein Mond
und ein Blitz oberhalb des Wagons eingezeichnet. Drittens sollte man sich Rat von Fachleuten
holen. Daher wird ein Papier neben den Lastwagen gezeichnet und „Plan” darauf geschrieben.
Viertens muss sicher gestellt werden, dass der Wagon sich beim umladen nicht bewegt. Daher
werden kleine rote Keile bei den Rädern eingezeichnet. Damit befinden sich alle wichtigen Inhal-
te gewissermaßen auf der Folie.

Im Allgemeinen sollte man ein Bild nur dann verwenden, wenn es zu dem Vorgetragenen etwas
hinzufügt. Schließlich ist noch wichtig, nicht zu schnell vorzutragen. Man muss mit dem Publi-
kum reden und darf nicht auf das Publikum einreden und sollte immer daran denken, dass man
mit der Präsentation etwas vermitteln will. Calligra Stage ist ein Werkzeug. Es kann nützlich sein,
aber dessen Verwendung macht die Präsentation nicht automatisch gut.
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Kapitel 5

Die Menüleiste und die
Werkzeugleisten

Neil Lucock
Krishna Tateneni
Anne-Marie Mahfouf
Deutsche Übersetzung: Hans-Frieder Hirsch

Calligra Stage hat eine Benutzeroberfläche mit verschiedenen Möglichkeiten, um das Programm
zu bedienen. Am bekanntesten wohl die Menüleiste oben im Fenster von Calligra Stage.

Durch Klicken auf einen Eintrag in der Menüleiste wird eine Liste von möglichen Aktionen an-
gezeigt, von denen Sie eine auswählen können. Viele dieser Aktionen kann Sie auch über die
Tastatur auslösen, indem sie den zugehörigen Tastatur-Kurzbefehl, der aus Strg oder Alt und ei-
ner weiteren Taste besteht, eingeben. Alle Befehle des Menüs werden im Folgenden beschrieben.

5.1 Die Werkzeugleisten

5.1.1 Veränderung der Werkzeugleisten

Neben der Menüleiste gibt es in Calligra Stage eine Werkzeugleisten, die aus einigen Symbolen
besteht. Diese Symbole sind Abkürzungen zu Menübefehlen.

Sie können die nicht gesperrte Werkzeugleiste verschieben, indem Sie sie am Griff links ziehen.
Werkzeugleisten können an jeder Seite des Calligra Stage-Fensters „angedockt” oder angehängt
werden. Werkzeugleisten können auch in einem eigenen Fenster unabhängig vom Calligra Stage-
Fenster „schwebend” angeordnet werden.

Falls Sie die Werkzeugleiste nicht ziehen möchten, klicken Sie stattdessen mit der rechten
Maustaste auf die Werkzeugleiste, um das Kontextmenü zu öffnen.

Wählen Sie im Menü den Eintrag Textposition, erscheint ein zusätzliches Menü mit verschie-
denen Einträgen, um das Erscheinungsbild der Werkzeugleiste einzustellen. Dieses zusätzliche
Menü wird im nächsten Bildschirmfoto dargestellt:
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Sie können die Einträge der Werkzeugleisten auch als Text an Stelle der Symbole oder als Kom-
bination aus Symbol und Text anzeigen lassen. Bei der letzten Möglichkeit können Sie außerdem
wählen, ob der Text neben oder unter dem Symbol angezeigt wird.

Werden in der Werkzeugleiste nur Symbole angezeigt. setzen Sie den Mauszeiger auf das Symbol
und warten einen Moment. Dann erscheint ein Hinweis in hervorgehobener Schrift.

Der Eintrag Ausrichtung im Kontextmenü legt die Anordnung der Werkzeugleisten fest. Alle
vier Seiten des Calligra Stage-Fensters können hier ausgewählt werden.

Im folgenden Abschnitt werden die Menüs von Calligra Stage erläutert.

5.2 Das Menü Datei

Datei → Neu (Strg+N)

Beginnt eine neue Präsentation. Im Startdialog können Sie eine Vorlage für Ihre Präsentati-
on auswählen.

Datei → Öffnen ... (Strg+O)

Öffnet eine vorhandene Präsentation. Im Standard-KDE-Dateidialog können Sie die zu öff-
nende Datei auswählen.

Datei → Zuletzt geöffnete Dateien

Zeigt eine Auswahlliste der zuletzt geöffneten Dateien an.

Datei → Speichern (Strg+S)

Speichert die aktuelle Präsentation. Falls die Datei bisher noch nicht gespeichert wurde,
müssen Sie einen Dateinamen eingeben. Ansonsten wird der aktuelle Dateiname verwen-
det.

Datei → Speichern unter ...

Speichert die aktuelle Präsentation unter einem neuen Namen.

Datei → Erneut laden
Lädt die geöffnete Datei erneut.

Datei → Importieren ...

Importiert eine vorher in einem von mehreren gebräuchlichen Formaten erstellte Präsenta-
tion.
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Datei → Exportieren ...

Exportiert die aktuelle geöffnete Präsentation in eines von mehreren gebräuchlichen For-
maten. Das ermöglicht die Nutzung der Präsentation mit einem anderen Programm oder
zum Austausch mit jemandem, der nicht über Calligra Stage verfügt.

Datei → Versenden ...
Öffnet eine neue E-Mail in Ihrem E-Mail-Programm mit dem aktuellen Calligra Stage-
Dokument als Anhang.

Datei → Als HTML exportieren ...

Startet den HTML-Assistenten, der im Abschnitt Abschnitt 3.1 erläutert wird.

Datei → Drucken ... (Strg+P)

Druckt die Präsentation. Genauer wird der Dialog mit den Einstellungen zum Drucken
geöffnet, damit man die Einstellungen vor dem Ausdruck anpassen kann.

Datei → Druckvorschau ...
Zeigt die Präsentation mit einem Programm zur Darstellung von PostScript®, so wie sie auf
einem Ausdruck aussehen würde.

Datei → Dokument-Informationen
Erlaubt die Eingabe von Informationen über das Dokument. Hier können Informationen
über den Autor und eine Zusammenfassung des Inhalts abgelegt werden.

Datei → Schließen (Strg+W)

Schließt die aktuelle Präsentation. Vorher haben Sie die Möglichkeit, Änderungen zu spei-
chern.

Datei → Beenden (Strg+Q)

Beendet Calligra Stage. Vorher können Sie alle geänderten Präsentationen speichern.

5.3 Das Menü Bearbeiten

Bearbeiten → Rückgängig: Letzte Aktion (Strg+Z)

Macht die letzte Benutzeraktion rückgängig.

Bearbeiten → Wiederherstellen: Letzte rückgängig gemachte Aktion (Strg+Umschalt+Z)

Stellt die letzte rückgängig gemachte Aktion wieder her. Falls keine Aktion zum Wieder-
herstellen vorhanden ist oder die letzte Aktion nicht rückgängig gemacht werden kann, ist
dieser Menüeintrag deaktiviert.

Bearbeiten → Ausschneiden (Strg+X)

Kopiert den ausgewählten Abschnitt in die Zwischenablage und entfernt ihn aus dem Do-
kument.

Bearbeiten → Kopieren (Strg+C)

Kopiert den ausgewählten Abschnitt in die Zwischenablage.

Bearbeiten → Einfügen (Strg+V)

Fügt den Inhalt der Zwischenablage in die Präsentation ein.

Bearbeiten → Löschen (Strg+Entf)

Entfernt den ausgewählten Abschnitt aus der Präsentation.
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Bearbeiten → Alle auswählen (Strg+A)

Wählt alle Objekte und Texte auf der aktuellen Folie aus.

Bearbeiten → Auswahl aufheben (Strg+Umschalt+A)

Hebt die Auswahl der aktuell ausgewählten Objekte auf.

Bearbeiten → Suchen ... (Strg+F)

Sucht einen Text in der Präsentation.

Bearbeiten → Weitersuchen (F3)
Sucht das nächste Vorkommen eines Textes in der Präsentation.

Bearbeiten → Frühere suchen (Umschalt+F3)
Sucht das vorherige Vorkommen eines Textes in der Präsentation.

Bearbeiten → Ersetzen ... (Strg+R)

Ersetzt in der Präsentation eines oder mehrere Vorkommen eines Textabschnittes mit einem
anderen Textabschnitt.

5.4 Das Menü Ansicht

Ansicht → Neue Ansicht
Öffnet ein weiteres Fenster mit der gleichen Präsentation. Damit können gleichzeitig an
mehreren Folie arbeiten.

Ansicht → Normal (Strg+F5) View → Anmerkungen (Strg+F6) View → Foliensortierung
(Strg+F7)

Mit diesen Aktionen wechseln Sie zwischen den Ansichtsmodi: Normal, in dem Sie die
Folien bearbeiten, Anmerkungen zeigt eine Vorschau der Folien mit einem Textfeld für Ihre
Notizen und die Ansicht Foliensortierung, in der Sie Folien umbenennen, ausschneiden,
kopieren und einfügen sowie die Folien für die Präsentation umsortieren können.

Ansicht → Folienmaster anzeigen (Strg+F8)

Schaltet die Anzeige des Folienvorlage ein bzw. aus. Auf der Folienvorlage fügen Sie alle
Objekte ein, die auf jeder Folie Ihrer Präsentation erscheinen soll.

Ansicht → Gitter anzeigen

Wenn diese Option aktiviert ist, zeigt Calligra Stage ein Punktgitter an. Diese Punkte re-
präsentieren die Schnittpunkte eines Gitters aus wagerechten und senkrechten Linien. Sie
dienen zur exakten Positionierung von Objekten auf der Folie.

Ansicht → An Gitter ausrichten
Wenn diese Option markiert ist, werden verschobene oder neu erstellte Objekte mit ihrer
linken oberen Ecke auf dem nächstliegenden Gitterpunkt „einrasten”.
Trotzdem können Sie Objekten auf der Folie beliebig anordnen. Diese Option hilft aber bei
der genauen Ausrichtung von Objekten. Bei Bedarf kann diese Funktion schnell ein- oder
ausgeschaltet werden.

Ansicht → Hilfslinien anzeigen

Wenn Sie mit Calligra Stage arbeiten, können Sie sowohl vertikale als auch horizontale
„Hilfslinien” vom Lineal in das Dokument ziehen. Diese Hilfslinien werden weder ge-
druckt noch bei der Bildschirmpräsentation angezeigt, sie dienen lediglich der korrekten
Ausrichtung von Objekten auf dem Bildschirm. Wenn dieses Element aktiviert ist, sind die
Hilfslinien sichtbar, ansonsten nicht.
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Hilfslinien werden auf allen Folien angezeigt, so können Objekte auf mehreren Folien an
der gleichen Stelle angeordnet werden.
Durch das Ausblenden werden Hilfslinien nicht gelöscht. Sobald Sie diese Einstellung wie-
der einschalten, werden die vorher erzeugten Hilfslinien wieder angezeigt.

Ansicht → Zoom
In diesem Untermenü können Sie die Anzeige der Folie vergrößern oder verkleinern. Es
gibt einige vordefinierte Vergrößerungsstufen, darunter auch Ganze Seite, mit der die ge-
samte Folie im Programmfenster dargestellt wird, und An Breite anpassen für eine Ver-
größerung, in der die Folie in voller Breite im Fenster angezeigt wird. Dabei müssen Sie
vertikal mit den Bildlaufleisten blättern. Es gibt außerdem einige fest vorgegebene Vergrö-
ßerungsstufen von 33 % bis 500 %.

5.5 Das Menü Einfügen

Einfügen → Variable
Hier können Sie eine Variable einfügen, die mit einem Wert belegt ist, der sich mit der
Bearbeitung des Dokuments ändert.

Einfügen → Vorführung importieren ...
Fügt eine vorhandene Präsentation ein. Im Standard-KDE-Dateidialog können Sie eine
ODP-Präsentation (.odp) öffnen, diese Daten werden nach der letzten vorhandenen Folie
in Ihr Dokument eingefügt.

Einfügen → Bilder als Folie einfügen ...
Mit diesem Menüeintrag fügen Sie ein oder mehrere Bilder ein, jedes Bild auf einer neuen
Folie. Damit können Sie schnell eine Diaschau erstellen.

Einfügen → Scan erstellen ...
Liest ein Bild von einem Scanner ein. Dazu muss ein Scanner installiert sein. Damit wird der
Scannerdialog geöffnet, in dem Sie die Einstellungen für den Scanner auswählen können.

5.6 Das Menü Format

Format → Schriftart ...
Im Dialog Schriftart auswählen finden Sie Einstellungen für den ausgewählten Text:
In diesem Dialog können Sie die Schriftart, den Schriftstil und die Schriftgröße für den
ausgewählten Text ändern. In der Vorschau unten im Dialog können Sie Ihre Einstellungen
kontrollieren.

Format → Absatz ... (Strg+Alt+P)
Im Dialog Absatzformat können Sie Einrückung und Abstand, das allgemeine Layout, Zei-
lenabstand, Listen und Nummern sowie Dekorationen einstellen.

Format → Stilverwaltung (Strg+Alt+S)
Mit Hilfe der Stilverwaltung können Sie einen Satz von Formateinstellungen festlegen, die
alle gemeinsam auf einen ausgewählten Text angewandt werden.

Format → Seitenlayout ...
Hier können Sie einige Einstellungen zur Seitengröße vorgenehmen. Sie können die Rän-
der, die Orientierung (Hochformat oder Querformat), und die Seitengröße bestimmen. Da-
zu gibt es viele Vorlagen wie z.B. DIN A4 oder US Legal.
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5.7 Das Menü Folie

Folie → Folie einfügen

Fügt eine neue Folie hinter der aktuellen Folie in das Dokument ein.

Folie → Folie kopieren

Kopiert die aktuelle Folie in die Zwischenablage.

Folie → Folie löschen
Löscht die aktuelle Seite aus der Präsentation. Vorher erscheint eine Sicherheitsabfrage.

Folie → Vorherige Folie (Bild auf)

Gehe zurück zur vorherigen Folie der Vorführung.

Folie → Nächste Folie (Bild ab)
Gehe zur nächsten Folie der Vorführung.

Folie → Erste Folie (Strg+Pos 1)

Gehe direkt zur ersten Folie der Vorführung.

Folie → Letzte Folie (Strg+Ende)

Geht direkt zur letzten Folie der Vorführung.

5.8 Das Menü Vorführung

Vorführung → Präsentation starten → Von aktueller Folie (Umschalt+F5)

Beginnt die Vorführung bei der aktuellen Folie.

Vorführung → Präsentation starten → Von erster Folie (F5)

Beginnt die Vorführung mit der ersten Folie.

Vorführung → Vorführung einrichten ...

Hier können die Eigenschaften der Vorführung festgelegt werden. Unter anderem wird die
Anzeigedauer der Folien festgelegt und es können Folien von der Vorführung ausgeschlos-
sen werden.

5.9 Das Menü Einstellungen

Das Menü Einstellungen erlaubt die Einrichtung von Calligra Stage.

Einstellungen → Werkzeugleiste anzeigen

In diesem Menü kann die Anzeige der Werkzeugleiste ein- oder ausgeschaltet werden.
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Einstellungen → Kurzbefehle festlegen ...

Über Kurzbefehle festlegen ... können Sie Tastaturkurzbefehle für Aktionen aus den
Menüs und Werkzeugleisten von Calligra Stage bestimmen.

Falls Sie einen bereits verwendeten Kurzbefehl neu zuordnen wollen, erhalten Sie einen
Warnhinweis. Wählen Sie den gewünschten Eintrag aus (im Bild der Kurzbefehl für Über
KDE).
Klicken Sie auf den Knopf Benutzerdefiniert und drücken Sie dann die Taste für den Kurz-
befehl. Im Beispiel wird Strg und Y für den Dialog „Über KDE”-Dialog verwendet.
Im Tastensymbol wird die aktuelle Zuordnung angezeigt. Durch OK wird der Dialog ge-
schlossen und die aktuellen Änderungen werden übernommen, Standard stellt die Stan-
dardeinstellungen wieder her und Abbrechen beendet den Dialog und verwirft die Ände-
rungen.

Einstellungen → Werkzeugleisten einrichten ...

Dieser Menüeintrag erlaubt die Anpassung der in den Werkzeugleisten angezeigten Sym-
bole.
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Oben befindet sich eine Auswahlliste für die zu bearbeitenden Werkzeugleisten. Im Bild
wurde die Werkzeugleiste Datei ausgewählt. Wenn Sie das Symbol Rechtschreibung zu
dieser Werkzeugleiste hinzugefügen wollen, klicken Sie auf diesen Eintrag in der linken
Liste. Dadurch wird das Symbol Pfeil rechts aktiviert. Durch Klicken auf diesen Pfeil wird
Andockbare Dialoge in die ausgewählte Werkzeugleiste aufgenommen. Der Pfeil nach
links ist aktiviert, wenn Sie die rechte Liste klicken. Damit entfernen Sie Einträge aus der
Werkzeugleiste. Sie können dann außerdem den ausgewählten Eintrag in der rechten Liste
mit den Pfeiltasten auf der Tastatur oder durch Klicken mit der Maus auf den Pfeil aufwärts
und abwärts verschieben und dadurch die Position des Symbols in der Werkzeugleiste ver-
ändern.

Einstellungen → Designs
Auswahl des Farbdesigns für das Calligra Stage-Fenster. Sie können eines der vordefinier-
ten Farbschemata auswählen oder mit Einrichtung ... das Modul Farben der Systemeinstel-
lungen öffnen.

Einstellungen → Stage einrichten ...
Im Kapitel Einrichten finden Sie eine vollständige Erklärung aller Einstellungen von Calli-
gra Stage.

5.10 Das Menü Hilfe

Hilfe → Handbuch zu Calligra Stage (F1)
Startet das Hilfe-System von KDE mit der Calligra Stage-Hilfe (diesem Dokument).

Hilfe → Was ist das? (Umschalt+F1)

Ändert den Mauscursor zu einer Kombination von Zeiger und Fragezeichen. Das Klicken
auf ein Element innerhalb von Calligra Stage öffnet ein Hilfefenster, das die Funktion des
Elementes beschreibt (sofern es Hilfe für das bestimmte Element gibt).

Hilfe → Probleme oder Wünsche berichten ...
Öffnet den Dialog für Problemberichte, in dem Sie Fehler und Wünsche berichten können.

26

help:/kcontrol/colors
help:/kcontrol/colors


Das Handbuch zu Calligra Stage

Help → Sprache der Anwendung umschalten

Öffnet einen Dialog zur Einstellung der Hauptsprache und Ausweichsprache für diese
Anwendung.

Hilfe → Über Calligra Stage

Zeigt Versions- und Autoreninformationen an.

Hilfe → Über KDE
Zeigt Versionsinformation und Grundsätzliches zu KDE an.
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Kapitel 6

Einrichtung von Calligra Stage

Neil Lucock
Krishna Tateneni
Anne-Marie Mahfouf
Deutsche Übersetzung: Hans-Frieder Hirsch

6.1 Der Einrichtungsdialog

6.1.1 Verschiedenes

Einheiten
Wählen Sie die Standardeinheit, die in Ihren Folien verwendet wird.

Radius der Ziehpunkte
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Wenn Sie ein Objekt mit dem Standardwerkzeug (Pfeil) auswählen, wird der Umriss mit
gelben und roten Quadraten angezeigt. Der Radius dieser Ziehpunkte (zur Größenände-
rung, Drehung usw.) legt die Größe diese Elemente fest, je größer desto einfacher sind sie
zu treffen.

Empfindlichkeit der Ziehpunkte
Mit dieser Einstellung geben Sie an, wie der Abstand zum Ziehpunkt für die Aktivierung
ist.

Versatz beim Einfügen
Dieser Versatz kann nur geändert werden, wenn Am Cursor einfügen abgeschaltet ist.
Wenn Sie mit ein Objekt mit den Kurzbefehlen Strg+C kopieren und mit Strg+V an ei-
ner Stelle einfügen, an der sich bereits ein Objekt befindet, wird das eingefügte Objekt um
diesen Wert nach rechts unten versetzt eingefügt.

Am Cursor einfügen
Deaktiviert den Versatz beim Einfügen und fügt ein Objekt immer an der Position des
Mauszeigers ein.

6.1.2 Gitter

GITTER

Gitter anzeigen
Wenn diese Option aktiviert ist, zeigt Calligra Stage ein Punktgitter an. Diese Punkte re-
präsentieren die Schnittpunkte eines Gitters aus wagerechten und senkrechten Linien. Sie
dienen zur exakten Positionierung von Objekten auf der Folie.

An Gitter ausrichten
Wenn diese Option markiert ist, werden verschobene oder neu erstellte Objekte mit ihrer
linken oberen Ecke auf dem nächstliegenden Gitterpunkt „einrasten”.
Trotzdem können Sie Objekten auf der Folie beliebig anordnen. Diese Option hilft aber bei
der genauen Ausrichtung von Objekten. Bei Bedarf kann diese Funktion schnell ein- oder
ausgeschaltet werden.
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Gitterfarbe:
Stellen Sie hier die Gitterfarbe ein, als Standard ist Schwarz vorgegeben.

ABSTÄNDE

Waagerecht:

Einstellung des waagerechten Abstandes zwischen Linien des Gitters. Standard ist 0,5 cm.

Senkrecht:
Einstellung des senkrechten Abstandes zwischen Linien des Gitters. Standard ist 0,5 cm.

6.1.3 Dokument

DOKUMENT-EINSTELLUNGEN

Intervall für automatisches Speichern:

Stellen Sie hier die Zeit für die automatische Sicherung ein. Mit Keine automatische Siche-
rung schalten Sie die Sicherung aus. Sie können hier einen Zeitraum von 1 bis 60 Minuten
eingeben.

Sicherungsdatei erstellen:

Ist diese Einstellung aktiviert, wird eine Sicherungsdatei .<name>.odp.autosave.odp im
Ordner der geöffneten Datei angelegt. Diese Sicherungsdatei können Sie bei Problemen
mit dem Original verwenden. Die Sicherungsdatei wird jedesmal neu geschrieben, wenn
Sie Ihr Dokument speichern oder wenn eine automatische Sicherung ausgeführt wird.
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6.1.4 Autor

Wählen Sie aus dem Auswahlfeld eine Autorprofil für Ihr Dokument.

Um neue Profile hinzuzufügen oder vorhandene zu löschen, benutzen Sie die Knöpfe rechts ne-
ben dem Auswahlfeld mit den Autorprofilen.
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Kapitel 7

Danksagungen und Lizenz

Calligra Stage

Copyright des Programms 1998-2000 Reginald Stadlbauer reggie@kde.org

Aktueller Betreuer ist Laurent Montel montel@kde.org.

MITWIRKENDE:

• Werner Trobin trobin@kde.org.

• David Faure faure@kde.org

• Toshitaka Fujioka fujioka@kde.org

• Lukáš Tinkl lukas@kde.org

• Thorsten Zachmann T.Zachmann@zagge.de

• Ariya Hidayat ariya@kde.org

• Percy Leonhardt percy@eris23.de

Die Dokumentation basiert auf der unter Copyright für 1999-2000 von Krishna Tateneni
stehenden Arbeit. Weitere Teile stehen unter dem Copyright 2000-2002 von Neil Lucock
neil@nlucock.freeserve.co.uk und 2005 Anne-Marie Mahfouf annma@kde.org.

Übersetzung Stephan Johachhunsum@gmx.de

Diese Dokumentation ist unter den Bedingungen der GNU Free Documentation License veröf-
fentlicht.
Dieses Programm ist unter den Bedingungen der GNU General Public License veröffentlicht.
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Anhang A

Installation

Calligra Stage ist Teil des KDE-Projekts http://www.kde.org/ .

Calligra Stage finden Sie auf der Seite download.kde.org des KDE-Projekts.

Anleitungen, um KDE-Programme auf Ihrem System zu kompilieren und zu installieren, finden
Sie auf der KDE-Techbase
Da KDE cmake benutzt, sollte es dabei keine Schwierigkeiten geben. Sollten dennoch Probleme
auftauchen, wenden Sie sich bitte an die KDE-Mailinglisten.
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